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Scenario Generation 

• The scenario generation and editing functions in MACS are the 
primary means by which traffic scenarios are created for use 
in simulations and testing 

• The scenario generation tools allow for a great deal of 
flexibility in what can be tested 

• To date, a variety of traffic situations have been created that 
simulated current day operations both in the terminal and en 
route domains as well as far-term environments with 2-3 
times current traffic levels and different levels of aircraft 
equipage 
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Typical questions that guide the process 

• What is the airspace of concern? 

• What are the targeted traffic loads for that airspace? 

• What is the duration and scope of the problem? 

• What are the equipage assumptions? 

• How structured does the traffic need to be? 

• What, if any, are the desired interactions of the traffic? 

– Conflicts, arrival/departure flows, metering 
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Getting Started 

• Open MACS via double-clicking the Example_ZOB 
“Developer.bat” shortcut 

– C:\Experiments\Example_ZOB\MacsStart\Admin 

 

 

 

 

– Switch to the A/C “tab”, and close and re-open the windows 
there: 

• Scenario Editor, AC Table Editor, SIM TOOL 

 

 



Common Tools 

• The two most common tools used for traffic 
development and editing are the AC Table Editor 
spreadsheet and the graphical Scenario Editor. 
 
• They are often used in tandem and interface 
with one another, so it is useful to have them 
both up together.  



• MACS initializes in Simulation mode by default. Editing can only be done in the 
Editor mode. To switch modes, first enable the SimTool by clicking on its item in 
the title bar. 
 
• Click on the SimTool’s drop-down menu that is currently set to Simulation. 
 
• Select Editor from the menu to enter the Editing mode. 
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•Multiple places to switch between Traffic files 
 

•    Different “synched” locations to select traffic file from  
 

 - Sim Tool: “Browse” button 
 

 - AC Table Editor, Scenario Editor: “File -> open”  
 
**note: Sim Tool not updating when Scenario Editor “File -> open” is used 
 

• Change from “10_AC_Sample_Traffic.txt” to “SA5_Sample_Traffic.txt” 
(and then back) 
 

**note: The number of aircraft  total/selected, load times, etc. 

Opening Traffic Files 



AC Table Editor 

• The AC Table Editor displays the loaded traffic file as a spreadsheet and can be used as such. 
 
• The columns of values can be arranged according to preference by clicking and dragging the 
heading cell of a column to its desired location. This is a useful feature as it is often helpful to 
group certain columns together for review. 
 

 
 



AC Table Editor 

• Selecting a single aircraft in the table will display its associated text in bold for reference. 
 
• Its callsign, route, and filedRoute will be displayed in the respective text windows as shown. 
 
•The callsign, route, and filedRoute can be edited from the upper windows without the need 
to do so in the individual table cells. (e.g. as a shortcut/quick access point) 
 
•The AC Table Editor has a search function that allows the user to search the entire file for 
specific callsigns, certain strings within a route/filedRoute, or strings within comment entries. 



AC Table Editor: Column Headings 
Each column has a fly-out menu that can be accessed 
by right clicking the column’s heading cell. 

Sorts the file in ascending order of the column’s values. 

The editor has error checking for each field, with errors displayed in red text.  
Selecting this will bring all rows with errors in the selected column to the top. 

Changes made in other columns will not affect values in this column. 

Changes made within an associated column will propagate to the column set 
to auto update. For example, setting the altitudeTarget or cruiseAltitude to 
35000 will update the corresponding altitude cell to 35000.*  

Sets the column value of all selected aircraft to the text box entry. 

Selecting each option will have the following results: 

*Updates will only propagate if the “Propagate Edits” checkbox is checked 



AC Table Editor: Error Checking 

Each aircraft with an error in any field has its callsign highlighted. 

Text in the field(s) containing errors are shown in red. 

The filedRoute and route fields have tool tips displayed when hovered over that 
identify what is causing the specific error. 

Selecting this option from the flyout menu will “fix” the error. Exercise 
some caution when using this feature as some changes may not reflect 
your intent. 



AC Table Editor Features 

For the purposes of these slides, the Edit and Tools functions are too numerous to  go into 
detail. It is recommended to simply try these out and get a feel for how the different options 
will best suit your needs.  
The following slides cover a small selection of frequently used features in each of the menus.  
 
Short sample activity/task to follow after I review a few of these.  
 



AC Table Editor: Select Edit Functions 
Undo returns to the previous state prior to the 
last change. Redo reincorporates the previous 
change. 
 Makes exact duplicates of selected aircraft 

with the exception of new, unique callsigns. 
Can be performed on one or multiple 
selections.   
 

Removes the selected aircraft from the 
scenario file. 

Removes all non-selected aircraft. Only the 
selected aircraft remain following this action. 



AC Table Editor: Select Tools Functions 

Displays the predicted sector load counts based 
on the traffic. Requires the Load Graph Window 
to be properly setup and displayed.  

Activates a pop-up window through which an 
aircraft’s position can be moved forward or 
backward along its route according to a 
specified time (in seconds). 

Occassionally changes can force an aircraft 
off of its route, which would mean it 
would be “free track” during the run. This 
feature attempts to place all selected 
aircraft back onto their route. 

Activates a pop-up window through which 
the user can specify a percentage of the 
selected aircraft to remove from the file.  



Scenario Editor 

 
• The Scenario Editor allows the user to load and graphically manipulate aircraft within the file. 
• It is often used in conjunction with the SimTool. 
• Dragging the SimTool’s time slider (while in Editor mode) will update the aircraft positions to 
reflect their predicted positions at the given time. 
 



Scenario Editor: Display 

Displays a solid line for the selected aircraft’s trajectory to be flown from scenario start. 

Displays a dashed line for the “flown” portion of the selected aircraft’s trajectory. 

Displays the data tags for selected aircraft (dependent upon data tag rule settings).  

Allows aircraft to be dragged anywhere, regardless of route. Sets editor time to zero.  

Displays the points at which an aircraft will penetrate convective weather.  



Scenario Editor: Aircraft Selection 

 
• Individual aircraft can be selected in the Scenario Editor by left-clicking on the target symbol. 
• Multiple aircraft can be selected together by left-clicking and dragging a box around the 
desired aircraft (as shown on the left). 
• To add aircraft to the selection, hold down the Shift key and left-click on the additional 
aircraft or draw another box. 
• To remove aircraft from the selection, hold down the Shift key and left-click on the selected 
aircraft. 
• Routes for selected aircraft can be displayed (see right panel) by selecting the Traj checkbox in 
the menu bar. 
 



Scenario Editor: Route Modifications 

 
• Aircraft routes can be modified by left-clicking anywhere along the route line and dragging the point 
to the desired location. Multiple routes can be modified by selecting overlapping/common points. 
• If VORs or Fixes are not displayed, or if the point being moved is placed in an unnamed location, that 
point will be defined by a lat-long position. 
• Dragging a point to a named location will snap it to the location and the name of the VOR or Fix will 
appear in the aircraft’s route. 
• To display named locations, (un)check the Show VORs or Show Fixes boxes in the Display menu. 
• To remove a point on the route simply right-click the point. 

Multi-aircraft route modification 



Scenario Editor: Aircraft Properties 

• Right-clicking on an individual 
aircraft will open a flyout menu. 
• The menu options displayed can 
be updated through additional 
menu options by dwelling the 
mouse pointer over the desired 
field. 

• The position of one or more selected aircraft can be moved 

forward or backward along the route by navigating to the 
Tools menu and selecting Move Aircraft… 
• The desired time and direction can be entered into the 
resulting window. 
• A shortcut is to select the aircraft and then hit any number 
between 1-9 and it will move forward that number of 
seconds * 100 (e.g., 5 = 500 seconds). To move backward, 
hold the Ctrl key down while pressing the number. 
 



Scenario Editor: Load Assessment 

• The traffic loads for particular sectors can be viewed through the Load Graph Window. 
• To display the window: in MACS’ main menu bar navigate to Windows      Analysis Views      
and select Load Graph Window.    
• The sectors to view in the Load Graph and the specifications for the window must first be 
defined in the traffic load setup file.    
• To view the loads, in the AC Table Editor or Scenario Editor select Generate AC Per Sector 
Count Data in the Tools dropdown menu as shown above. 



Going Forward 

• The preceding slides covered a small subset of 
the scenario development capabilities available in 
MACS. 

• The best way to learn is to just try out the 
different tools and develop your own style and 
strategy.  

• The scenario development tools are a work in 
progress. Let us know of serious errors that you 
uncover or any ideas for improvement that you 
may have. 



Final Note 

Scenario development is an iterative process. 
Using the editing and development tools offline 
only gets you part of the way to the final 
product. It is critical to play the scenarios in 
Simulation mode, in real-time, in exactly the 
same way that the final study will be conducted. 
There are always differences that arise due to a 
variety of reasons that will only be noticeable 
when doing so. 



Hands-on Sample Activity 

Create a new flight AAL123 from PHL to MSP 

via PSB, YNG, GRR at cruise alt 36,000 
• duplicate SWA1790, in “callsign” column rename 

to AAL123 

• In “filedRoute” column, change  
from “PHL./.PSB.j60.IOW..LBF..DEN”  
into “PHL./..PSB..YNG..GRR..MSP” (press enter) 
• Auto propagation updates “route” and “destination” 

• Note change in displayed route in Scenario Editor 

• Change “filedRoute” to avoid sector 26.  
• Insert “CLE” between “YNG” and “GRR”  

 

 



Hands-on Sample Activity 

  

 

 

 

 

 

 

 

Change the cruise altitude 
• Set “altitude” and “altitudeTarget” columns to “auto update” 
• Change “cruiseAltitude” to 36000 

 

Start just before sector 59 
• Tools -> Move Aircraft … 

• Uncheck change to timetoEnter 

• Move aircraft backward by 700 seconds 
• Note the plane travel backwards along the dashed line 
 

YOU TRY:  
 New plane AAL999, PHL to MSP, start just before 
 sector 79 (go via 79 and 26), altitude 34000 

 

  

 
 



Hands-on Sample Activity 
View the traffic  

– In “Editor Mode” drag the scenario editor time slider 
note: observe the Scenario Editor display 
 
 
 
 

 
 

DON’T FORGET TO SAVE BETWEEN SWITCHING FROM EDITOR TO SIMULATION MODE 

 
– In “Simulation Mode” play in real or accelerated times 

note: observe in the DSR or TSD air traffic controller displays 
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Generating Convective Weather with the 
Convective Weather Editor 

Chris Cabrall 

Slides by Matt Mainini 



Outline 

• What is the goal? 

• What is the Convective Weather Editor? 

• What are the capabilities and assumptions of the Weather 
Editor? 

• What is the general process? 

• Overview of Convective Weather Editor features 
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What is the goal?  

The main goal of the Convective Weather Editor is to 
generate realistic convective weather to display on the 
DSR or TSD in which the operator may view and interact 
with. 
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What is the Convective Weather Editor? 

The Convective Weather Editor is a tool within MACS 
that enables the user to sequentially combine 
convective weather images that appear as realistic 
weather formations in real time. 
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What are the capabilities and assumptions 
of the Weather Editor? 

• Capabilities 

– Generate realistic weather cells 

– Multiple simultaneous weather cells 

– Weather looping 

– Predicted future weather 

– Displayed on DSR and/or TSD 

– Weather probe 

• Assumptions 

– Weather images have been prepared for MACS read-in 

– The general location, size, direction, and number of cells have been 
considered 
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The process of generating MACS weather 

• The basic process 

– Weather images are captured from NOAA 

– Images are prepared for MACS with Photoshop 

– Images are loaded in Convective Weather Editor window 

– Images, or “patterns,” are stitched together and edited in 
time, or “steps,” to create morphing convective weather 
cells, or “paths” 

– The “paths” are saved as an .xml and are played back as 
realistic weather cells on the DSR or TSD 
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Relevant Files/Folders 

• Wx Image folder 
C:\Experiments\SA5\MacsScenarios\Weather\Weather\WxImageFolder\ 

• WX_TAG_SM_MODE file  
C:\Experiments\SA5\MacsSetup\ WX_TAG_SM_MODE.xml 

 

 

 

 

 

MACS Workshop, 1/10 - 1/11, 2012 



Setup the Weather Editing Environment 

• Open MACS in developer-lite mode  
 (e.g. with the Example_ZOB “developer.bat” file) 

• Places MACS into “editor” mode  
 (i.e. not “simulation” or “playback” mode) 

• Go to Windows/Setup Panels/Weather -> “Wx Selection tab” and check 
the box next to “Convective Weather” 

• Press “Browse/Load” button, find, and select the sa5_wx_2.xml file 

– C:/Experiments/Example_ZOB/MacsScenarios/Weather/sa5_wx_2.xml 
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Setup the Weather Editing Environment 

• Open the “STARS” tab and on it place: 

• Windows\Scenario Editor\Scenario Editor 

• Windows\Scenario Editor\Convective Weather Editor 

• SimTool 
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Setup the Weather Editing Environment 

• Ensure weather viewing on various ATC station displays is turned “on” 
 Windows\Setup Panels\DSR_1\DSR_1 PlanViewSetup 
 Windows\Setup Panels\TSD_1\TSD_1 PlanViewSetup 
 Windows\Setup Panels\Scenario_Editor PlanViewSetup 

• Can display different levels (low, medium, high) in different colors on 
different displays 
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Wx Color to  
Intensity Editor 
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Convective Weather Editor 
• Windows\Scenario Editor\Convective Weather Editor 

 

 
   

 

 

 

 

 

 

 

 

 

 

 



Hands-on Sample Activity 
Extend the weather pattern for another half hour, 
have it continue to move eastward , but die out. 

 

• Save the .xml weather file with new name 
• Convective Weather Editor “File -> Save as …” 

– Note: the folder location where it’s being saved  

• Save as “SampleWxActivity.xml” under 
C:/Experiments/Example_ZOB/MacsScenarios/Weather/ 
– Note: the file name may have changed when browsing. 

 

• Change the length from 1.5 to 2 hrs 
• Convective Weather Editor “Edit -> Edit Properties” 
• Change number of steps from 15 to 20, press “OK” 
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Hands-on Sample Activity 
Review each “step” (cell) in the “path” (row) in the 
Convective Weather Editor  

• In order from left to right, left click each “step” 
– Note: the time slider advances on the Sim Tool 
– Note: the planes advance in the Scenario Editor 
– Note: the “pattern” (image) changes in the Convective 

Weather Editor; also note the “names” of each pattern 
 
 
 
 
 
 
 
Note: we have not yet loaded “patterns” into the newly 
created last 5 “steps” of the “path” 
 

… … … 

MACS Workshop, 1/10 - 1/11, 2012 



Hands-on Sample Activity 
Load pattern “30” into the 01:30:00 step 

• Double left click on the “step” (cell) beneath 
“01:30:00” column heading 

- Note: the “edit step” window opens 
• Click the pattern selection drop down box (it is 

currently set to “none”) and select pattern 
“30” and press OK 
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Hands-on Sample Activity 
Compare the loaded pattern “30” at 01:30:00 with the 
previous step loaded pattern “31”at 01:24:00 

- Note: the location of the white circle (boundaries) and pink dot 
(center) of each step 

- Note: the Scenario Editor white circle corresponds to the 
Convective Weather Editor white circle…  

• In the scenario editor, left click the pink dot “center” of the 
01:30:00 pattern and drag it up near to the other step’s 
centers 
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Hands-on Sample Activity 
Note: the rotation is “off” in regards to the previous steps, with the 
weather to the north of the dot and not to the south-east… 
• Double left click the 01:30:00 step in the Convective Weather Editor 

table to open the Edit step window, and enter “115.0” for the 
pattern image “Rotation (degrees)” setting   
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Hands-on Sample Activity 
With the initial placement (center/pink dot) and rotation of the pattern 
image set for the step at 01:30:00, now update its direction and speed of 
travel for how it is to progress across its 6 minute time slot. 
 
• Double left click the 01:30:00 step in the Convective Weather Editor 

table to open the Edit step window, and enter “10.0” for Speed 
(knots) and enter 90.0 for Direction (heading) , and press OK 

 

MACS Workshop, 1/10 - 1/11, 2012 



Hands-on Sample Activity 
 
Continue with the last 4 time slots to fill the remaining steps with patterns “29”, 
“28”, “27”, and “26” 
 
• Double-click the desired step in the Convective Weather Editor 
• Use the “Edit Step” window’s pull-down menu to select the desired pattern 
• Left click on pink dot in Scenario editor to move the center of the pattern 

rotate 
• Adjust rotation, speed, heading settings under “Edit Step” window 

 
Other things to try: 
• Re-scale the pattern image in each progressive step to “reduce” the weather 

so it gets smaller and “dies out” in this last half-hour 
• Choose or create and place in new pattern images with less severity (less red, 

more green, etc.) 
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Other Important 
Menu Options 
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Hands-on Sample Activity 
View the weather  

– In “Editor Mode” drag the scenario editor time slider 
note: observe the Scenario Editor display 
 
 
 
 

 
 

DON’T FORGET TO SAVE BETWEEN SWITCHING FROM EDITOR TO SIMULATION MODE 

 
– In “Simulation Mode” play in real or accelerated times 

note: observe in the DSR or TSD air traffic controller displays 
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Contacts and References 
Jeff Homola: jeffrey.r.homola@nasa.gov (650) 604-4603 

Hwasoo Lee: hwasoo.lee@nasa.gov (650) 604-0764 

Christopher Cabrall: christopher.d.cabrall@nasa.gov (650) 604-2165 

 

Related guides on the MACS wiki: 

Traffic generation: 
https://aol1.arc.nasa.gov:8443/display/macs/Scenario+Editor+User+Guide 

Convective weather generation: 

https://aol1.arc.nasa.gov:8443/display/macs/Weather+1+-
+Overview+and+how+to+create+weather+patterns+to+be+loaded+in+MACS 

https://aol1.arc.nasa.gov:8443/display/macs/Weather+2+-
+How+to+Photoshop+weather+images+prior+to+MACS 

https://aol1.arc.nasa.gov:8443/display/macs/Weather+3+-
+How+to+use+the+MACS+Convective+Weather+Editor 
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